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Em que fases de uma transação de M&A, preciso de um 

advogado ? 

I - Na fase preliminar: Análise do projeto sob o ponto de vista jurídico do projeto e preparação para a concretização do 

mesmo: 

 

- O comprador e, mais especialmente, o vendedor podem identificar medidas preparatórias para a transação; por exemplo, 

do lado do vendedor, é bom alterar-se o quadro societário para que PFs sejam os vendedores (e não PJs/holdings, cuja 

tributação é mais elevada), ademais a empresa ou negócio-alvo pode ter alguns problemas que podem ser sanados para 

evitar um efeito negativo no preço; pode ser interessante conduzir-se um “vendor due diligence” (inclusive na área 

jurídica); 

- Formalização de quaisquer providências legais preparatórias para a transação; por exemplo, exclusão de ativos que não 

são contemplados pela transação, formalização de contratos quando não estiverem firmados por escrito ou quando suas 

disposições representem algum risco para o negócio; 

- Verificação sobre a necessidade ou não de obtenção de autorização governamental para a transação sob a legislação 

aplicável (por exemplo, do CADE ou de agência governamental, dependendo da atividade), o que pode influenciar o 

cronograma da transação; 

- Auxílio do vendedor na preparação de Information Memorandum ou Info memo, documento usado quando do processo de 

prospecção e busca de possíveis compradores.  

 

II – Elaboração e negociação de carta de intenções (ou letter of intent, LoI, memorandum of understandings, MoU, term-

sheet) ou de proposta de compra (ou offer-letter), contendo um resumo dos termos e das condições mais básicas para a 

transação.  

 

- Avaliação jurídica de possíveis estruturas para a transação e análise de questões sobre os conceitos mais essenciais 

aceitáveis entre as partes. 

 

III – Due diligence (auditoria), conduzida pela equipe do comprador e fornecimento de informações para este fim. 

Exemplificando, ao advogado do vendedor poderá caber o estudo de pontos como a abertura (ou não) de informações mais 

sensíveis ao comprador – muitas vezes um concorrente – de dados protegidos por cláusula de confidencialide, de 

informações excessivamente detalhadas – o que pode retardar o andamento do projeto. O “due diligence” do comprador 

normalmente implicará o envolvimento de uma equipe de advogados com diversas especialidades, como se verá adiante. 

 

 

 

 

 

 

 

-   
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Em que fases de uma transação de M&A, preciso de um 

advogado ? 

 

IV – Preparação e negociação de Contrato de Aquisição e de outros documentos para se formalizar e completar a transação. 

 

- O Contrato de Aquisição tratará de todas os direitos e obrigações do comprador e do vendedor em relação à transação, 

como se verá adiante; 

- Se a transação consistir na aquisição parcial do capital da sociedade-alvo, as partes também deverão negociar e assinar 

no fechamento um Acordo de Acionistas ou Acordo de Quotistas – um documento que é muitas vezes mais complexo que 

o próprio Contrato de Aquisição; 

- Se o comprador conseguir negociar uma garantia para a indenização do vendedor, no caso de surgimento de passivos ou 

problemas oriundos da gestão deste último, uma alternativa comum é a conta-custódia (o que abordaremos mais adiante), 

a ser aberta junto a um banco comercial; neste caso, as partes assinarão com contrato juntamemente com o banco 

envolvido;   

- Se, de comum acordo com o comprador ou a pedido deste último (o que é comum), os vendedores ou alguns deles 

decidirem continuar trabalhando no negócio adquirido, depois do Closing da transação, deverá se formalizar o tipo de 

relacionamento que cada um deles terá através de um contrato (contrato de trabalho ou contrato de consultoria);  

- Às vezes, tem-se visto aquisições – especialmente envolvendo “start ups” em que o vendedor recebe, como parte do  

preço, ações representante parte do capital do comprador; neste caso, a transação é mais complexa pois implica a 

assinatura de contratos adicionais – muitas vezes sob legislação estrangeira, se o comprador não for brasileiro – o que 

enseja o envolvimento de advogado que conheça a legislação aplicável a essa transferência de ações no exterior. 
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Algumas Considerações Preliminares 

 

- Diferenças culturais quando as partes são de nacionalidades distintas, com impacto mais 
acentuado em transações diretas comprador-vendedor : 

 

– Comunicações nem sempre tão fluidas entre brasileiros e estrangeiros ou até executivos brasileiros de 
empresas mais sofisticadas e os de empresas menores 

– Nível de sofisticação distinto; diferença organizacional (a Target muitas vezes nunca é/foi auditada) 

– Advisors: são muito úteis para o desenrolar de uma transação, mas precisam de diretrizes 

 

- Diferentes expectativas em termos de cronograma de cada lado da mesa de negociação. 
 

- Sistemas legais distintos, no caso de uma parte ser estrangeira:  

 
- Muitos estrangeiros tendem a escolher a estrutura de compra de ativos para a implementação de uma 

aquisição de negócio brasileiro, pois em diversos países, é possível eliminar-se ou limitar-se a sucessão 
em relação aos passivos anteriores ao Closing com essa estrutura; 

- No Brasil, a estrutura de compra de ativos não elimina riscos de sucessão para o comprador, sendo 
portanto comum a escolha de aquisição de participação societária; 

- É comum uma ótica bem distinta em relação a passivos na visão de estrangeiros: eles só enxergam 2 
opções – é legal ou é ilegal; já, o brasileiro entende muitas questões como pendentes, até decisão final do 
Judiciário...  

 

- Tratamento de passivos pré-fechamento materializados após o fechamento – o vendedor 
brasileiro tende a levar passivos para disputas que podem resultar em longos contenciosos 
(protelando a expectativa de indenização e a vigência de garantias).   
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Auditoria Jurídica ou Legal Due Diligence 

Consiste na avaliação legal da situação da empresa ou do negócio-alvo (Target). É conduzida em paralelo com a 

auditoria das outras áreas (financeira, contábil etc.), a auditoria jurídica normalmente cobre as principais áreas do 

direito das empresas, tais como as seguintes: societária, contratual, imobiliária, trabalhista, tributária, bancária e de 

controle cambial, propriedade intelectual. Pode também abranger as áreas: regulatória (se a Target envolver atividade 

regulada), concorrencial, ambiental, compliance ou outras. 

 

Segue uma breve descrição de algumas preocupações em uma auditoria jurídica no Brasil (abordaremos exemplos): 

 

A. Área Societária 

 

– Titularidade do capital da Target e ônus sobre as quota/ações da Target (exemplos de fundamental rep) 

– Autonomia corporativa do vendedor para efetuar a venda (idem) 

– Contingências advindas de transações anteriores de M&A envolvendo a Target 

– Existência de acordo de acionistas / quotistas e direito de preferência 

 

B. Controle Cambial – se necessário  

 

– Existência de pendência em relação a registros de investimento estrangeiro no Banco Central   

– Registros de empréstimo estrangeiro no Banco Central   

– Contenciosos administrativos 

 

C. Contratos Comerciais e Financeiros 

 

– Análise de documentos jurídicos confirmando direitos, dívidas e obrigações da Target  

– Verificação de garantias envolvendo a Target (por exemplo, penhor de ativos ou de quotas/ações) 

– Análise de cláusulas de mudança de controle, alteração societária ou venda de linha de negócio 
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Auditoria Jurídica ou Legal Due Diligence 

D. Propriedades Imobiliárias e Ativos mais Significativos  

 

– Confirmação de propriedade (bens próprios) e existência de ônus 

– Condições de contratos de locação, sub-locação, servidão e afins  

 

E.        Contencioso Civil e Comercial 

 

– Disputas judiciais ou pré-judiciais envolvendo a Target ou os vendedores 

– Análise de certidões forenses e relatórios dos advogados responsáveis pelas disputas envolvendo a 

Target   

 

F.          Assuntos Tributários 

 

– Análise de certidões fiscais (certidões “positivas”) e forenses  

– Revisão de fiscalizações, procedimentos administrativos e judiciais de natureza tributária 

– Incentivos fiscais e parcelamentos  

– Risk assessment em relação à due diligence conduzida pelos auditores 

 

G. Assuntos Trabalhistas 

 

– Análise de certidões trabalhistas 

– Revisão de fiscalizações, procedimentos administrativos e judiciais de natureza tributária 

– Contratos de trabalho (inclusive com administradores), acordos coletivos, contratos de terceirizados 

– Risk assessment em relação à  due diligence conduzida pelos auditores 
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Auditoria Jurídica ou Legal Due Diligence 

H. Assuntos Ambientais  

 

– Análise de licenças governamentais, inclusive das restrições nelas contidas 

– Verificação de requisitos contidos na legislação aplicável, inclusive de zoneamento 

– Revisão de fiscalizações, procedimentos administrativos e judiciais de natureza ambiental (inclusive no 

passado) 

– Informação sobre atividades insalubres, produtos perigosos ou controlados etc. 

– Avaliação de riscos de relatório de auditoria ambiental – se houver 

 

I. Assuntos Regulatórios (se a atividade for controlada por agência governamental, esse assunto é prioritário) 

 

– Verificação da necessidade de autorizações governamental para a transação (por exemplo, atividades 

reguladas) 

– Licenciamento da Target e/ou de seus produtos/serviços e atendimento das obrigações acessórias 

(pagamento de taxas devidas a agências regulatórias, por exemplo) 

 

J. Propriedade Intelectual 

 

– Busca e revisão de marcas, patentes, contratos registrados no INPI ou usados pelo negócio-alvo (o 

Comprador precisará dar uma noção de importância dos direitos de propriedade intelectual no âmbito 

do negócio-alvo) 

– Análise de oposições a pedidos de registro pleiteados no INPI 

– Revisão de contratos de transferência de tecnologia, de licenciamento de know-how e outros 
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Auditoria Jurídica ou Legal Due Diligence 

K. Antitruste  

 

– Análise prévia sobre o atendimento dos critérios para a apresentação de ato de concentração no CADE 

– Verificação de procedimentos anteriores envolvendo a Target (assim como o próprio comprador, se for 
o caso, ou até a área de atuação das empresas envolvidas na transação) 

 

L.        Compliance e anti-corrupção  

 

– Verificação dos pontos de contato entre a Target e autoridades ou entidades públicas 

– Análise de documentos (código de conduta, por exemplo) e procedimentos 

– Verificação de procedimentos criminais  

– Entrevista com executivos envolvidos na operação da Target 

– Quando houver envolvimento de outras equipes (auditores por exemplo), interação com elas. 

 

E, em relação à área de TI, temos os seguintes pontos, entre outros:  

M. Tecnologia da Informação 

 

– Titularidade de software ou, no caso de uso de sistema pertencente a terceiros, análise dos contratos 
que permitem o seu uso 

– Análise do contrato de trabalho de empregados envolvidos diretamente no desenvolvimento, alteração 
ou otimização de software  

– Aspectos relacionados com a gestão/guarda de informações e a preservação de sua confidencialiade  

– Contratos com cliente (responsabilidade, garantia) 



© 2016 Trench, Rossi e Watanabe Advogados 

INSTRUCTIONS 
How to apply a Slide Layout 

Go to the Home tab and select   

New Slide to choose from a  

variety of formatted B&M slide layouts 

Tip: choose Layout to reapply a layout to a 

selected slide(s) 

How to apply slide text styles 

Use the Decrease List Level and Increase 

List Level icons on the Home tab to apply 

the required text style 

Tip: use the Reset option from  

the Home tab to restore template text styles 

to a slide 

How to update footer and slide numbers 

Go to the Insert tab and select 

Header & Footer. Select Apply to 

All once update has been made 

9 

Disposições Relevantes – Contrato de Aquisição 
Seguem abaixo alguns dos termos e condições mais relevantes comumente incluídos em um contrato 
de aquisição. 

 

A.     Preço de Compra  

 

Definição do Preço de Compra  

 

- Com valor fixo  

- Com valor variável, por exemplo, contemplando a performance da Target (earn-out, por exemplo)  

- Inclusão de ajustes (por exemplo, com base no working capital e/ou na variação do balanço-base para o 
do fechamento) 

- Cash-free debt-free – um conceito que, embora auto-explicativo, é muito mais claro para o investidor 
estrangeiro do que para os brasileiros 

- Possibilidades de conflitos e discussões envolvendo conceitos financeiros (ex. discussão sobre cálculo de 
earn-out, ou valores para exercício de opção de compra, em aquisições parciais) 

  

Método de Pagamento 

 

- À vista, no Closing 

- Em parcelas, a primeira delas no Closing 

 

Forma de Pagamento 

 

- Em dinheiro; preferência por pagamento no Brasil em R$ para vendedor local  

- Em outras espécies (“swap” de ações, etc.) 
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Disposições Relevantes  – Contrato de Aquisição 

B. Obrigações Pos-Fechamento 

Previstas em cláusulas do Contrato de Compra e Venda 

Não-Concorrência 

 

 Obrigação do vendedor de não concorrer, direta ou indiretamente, com a Target na área geográfica em que 

atua. 

 Limitação geográfica e temporal (máximo de 5 anos). 

 

Não-Aliciamento 

 

 Obrigação do vendedor de não aliciar, oferecer a contratação ou contratar de qualquer forma, direta ou 

indiretamente qualquer empregado ou trabalhador envolvido nas operações da Target. 

 O período de tempo para essa limitação frequentemente acompanha o da não-concorrência. 

 

Obrigações mencionadas no Contrato de Compra e Venda mas formalizadas em documentos distintos 

- Acordo de Acionistas ou de Quotistas (aquisições parciais)   

- Contrato de Transição quando a transação prevê um período de adaptação com esforços 

conjuntos 

- Contrato de Trabalho ou de Consultoria,  com vendedor / pessoa física 

- Contrato de conta custódia em garantia 

Outros, dependendo do caso (ex. contratos comerciais, de distribuição ou de industrialização) 
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Disposições  – Contrato de Aquisição 

C. Declarações e Garantias (ou representations & warranties, ou ainda R&W) 

 

Em poucas palavras, as declarações e garantias do vendedor prestadas perante o comprador 

consistem em afirmações do vendedor em relação à sua capacidade e autoridade para efetuar a 

transação, sem restrições, e, especialmente, a sua confirmação formal quanto à situação detalhada 

da Target e de suas operações. O propósito dessas declarações e garantias é dar base para o direito 

do comprador de ser indenizado caso alguma R&W se revelar incorreta (vide detalhes mais adiante). 

 

As declarações e garantias do vendedor geralmente cobrem áreas tais como: 

 A propriedade da Target 

 A autoridade societária para a implementação da transação  

 A ausência de restrições para a finalização da transação  

 A precisão dos balanços financeiros e dos registros contábeis 

 A capitalização da Target (valor do capital, existência de opções de compra, etc.)  

 Assuntos de Propriedade Intelectual (PI) e de Tecnologia da Informação (TI) 

 A propriedade sobre imóveis ou móveis, existência de qualquer ônus 

 A titularidade sobre direitos e ativos de TI 

 Contenciosos (tributário, trabalhista, civil/commercial envolvendo a Target) 

 Assuntos trabalhistas e empregatícios  

 Questões tributárias 

 Matérias ambientais e de licenciamento governamental 

 Compliance e anticorrupção 

 



© 2016 Trench, Rossi e Watanabe Advogados 

INSTRUCTIONS 
How to apply a Slide Layout 

Go to the Home tab and select   

New Slide to choose from a  

variety of formatted B&M slide layouts 

Tip: choose Layout to reapply a layout to a 

selected slide(s) 

How to apply slide text styles 

Use the Decrease List Level and Increase 

List Level icons on the Home tab to apply 

the required text style 

Tip: use the Reset option from  

the Home tab to restore template text styles 

to a slide 

How to update footer and slide numbers 

Go to the Insert tab and select 

Header & Footer. Select Apply to 

All once update has been made 

12 

Disposições Relevantes – Contrato de Aquisição 
D. Disposições sobre Indenização 

 

A estrutura mais comum em transações de M&A, no Brasil, prevê conceitualmente que o vendedor 

responda por todos os passivos causados pela gestão pré-Closing da Target. 

 

Limitações 

 

Tempo: Embora o vendedor possa conseguir negociar prazos menores, geralmente o prazo que o 

comprador pedirá para a indenização pelo vendedor corresponderá ao de prescrição: 

 
-  neste sentido, é comumum approach conservador: limite de 5 anos para tudo, exceto assuntos 

ambientais (sem limite) 

- 5 anos para contingências trabalhistas (embora o reclamante tenha 2 anos para ingressar em juízo, após 

o fim da relação empregatícia) 

- 5 anos para contingências tributárias (além do ano corrente, para tributos sobre ganho de capitais) 

- Embora não haja prazo prescricional para problemas ambientais, é comum se convencionar algum prazo) 

- A identificação de risco de fraude (tributária, por exemplo) é causa para aumentar-se o prazo 

prescricional (cuidado com a definição de fraude que pode ser excessivamente abrangente) 

 

Cap: Muitos contratos de aquisição estabelecem um limite máximo para a obrigação do vendedor de 

indenizar (antigamente, o padrão era que esse limite correspondia ao preço de compra). 

  

Basket: Os passivos devem atingir um determinado patamar antes do vendedor começar a indenizar 

 

De minimis: Contingências abaixo de um determinado valor não são indenizadas pelo vendedor  
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Disposições Relevantes  – Contrato de Aquisição 

E. Garantias mais comuns dadas pelo vendedor (pode haver a combinação de várias) 

 

Retenção de parte do Preço de Compra (holdback) ou dedução sobre parcelas vincendas 

quando o pagamento é parcelado – Pode haver relutância do vendedor em deixar parte do preço na 

mão do vendedor e deve haver discussão sobre a atualização/juros sobre a parte retida 

 

Conta de custódia bancária (escrow account) – É a garantia mais comum – Pode haver discussão 

sobre a sua duração, quem arcará com os custos bancários e também sobre o tipo de investimento 

financeiro para os recursos 

 

Hipoteca sobre bens imóveis – Complexidade na execução: o valor do bem não corresponde  

necessariamente ao do passivo que enseja o uso da garantia e a indenização advém da venda em 

leilão do bem hipotecado 

 

Fiador pessoal/garantidor  

 

Penhor sobre bens móveis – Implica uma certa dificuldade de execução, além da cautela na escolha 

do bem com cautela (evitar o risco de o bem desaparecer ou perder todo o valor)  
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Disposições Relevantes  – Contrato de Aquisição 

F. Condições precedentes ao Closing (exemplos) 

 

Aprovação da transação pelo CADE quando necessária 

- A transação precisa ser submetida ao CADE em conjunto pelo comprador e pelo vendedor se o 

faturamento bruto de grupo econômico de uma das partes, apenas no Brasil, iguala ou supera R$ 750 

milhões e o faturamento do grupo econômico da outra parte, no Brasil, iguala ou supera R$ 75 milhões. 

- Vale a pena dizer que atualmente essa aprovação pode acontecer por meio do chamado fast-track, que 

demora cerca de 30 dias (além de um período de 15 dias para possíveis recursos – que são incomuns) 

- As partes poderão negociar um rateio ou escolher um responsável pelo pagamento de R$ 85 mil – custas 

devidas ao CADE (além dos honorários advocatícios) 

 

Obtenção de autorização de terceiros, sejam entes governamentais (agência regulatória) ou 

privados (credor da Target ou do vendedor) para a realização da transação 

 

Exclusão de itens impertinentes ao negócio da Target (carve-out de terreno sem utilização) 

 

Obtenção de licenças governamentais faltantes, de certidões negativas, etc. 
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Disposições Relevantes  – Contrato de Aquisição 

G. Arbitragem 

 

- A arbitragem no Brasil tem sido a escolha predominante para a solução de disputas entre 

comprador e vendedor, em razão da morosidade do Judiciário. 

- Há diversas câmaras arbitrais no Brasil com um bom quadro de árbitros (por exemplo, a Câmara 

Canadense, a FIESP, entre outras).  

- Embora mais rápida que o Judiciário brasileiro, a arbitragem é considerada cara por alguns (não 

vale a pena disputar valores menores em arbitragem) e o fato de dar decisões definitivas (sem 

possibilidade de recurso) também tem assustado um pouco as partes. 

 

H. Legislação brasileira 

 

- Muito comumente, as partes têm escolhido a legislação brasileira como aplicável para contratos de 

M&A envolvendo Targets locais. No caso de escolha de legislação estrangeira, aplica-se a lei 

brasileira em qualquer assunto de ordem pública. 

- A escolha da lei aplicável pode requerer uma análise mais profunda, por exemplo, se a transação 

implicar o pagamento de parte do preço com ações de empresa estrangeira.  
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Disposições Relevantes  – Acordo de Acionistas/Quotistas 

Abaixo, contemplamos alguns pontos relevantes comumente abordados num acordo de 

acionistas/quotistas. A importância destas cláusulas varia de transação para transação, 

especialmente em função do fato do interessado ter uma posição majoritária ou minoritária na Target. 

Esse documento é importantíssimo, pois formaliza direitos e deveres das partes como detentoras do 

capital da Target (ou seja, esse documento pode viger por diversos anos) e precisa ser arquivado na 

sede da Target. Contrariamente ao acordo de acionistas/quotistas que é confidencial, o estatuto ou 

contrato social da Target é público e apenas contemplará assuntos mais corriqueiros.  

 

A. Lock-up / Direito de Preferência / Não Diluição  

- Cláusula de lock-up: Vedação, por um período determinado, à transferência de ações/quotas 

- Direito de preferência na compra/venda/transferência de ações/quotas por qualquer 

acionista/quotista 

- Direito de preferência na subscrição de novas ações/quotas 

- Cláusula anti-diluição 

 

B. Tag-Along e Drag-Along 

- Tag-Along: Direito à venda da participação em condições semelhantes, caso outro acionista/quotista 

decida vender as suas ações/quotas na Target a um terceiro. 

- Drag-Along: Obrigação de venda da participação, em geral em condições semelhantes, caso outro 

acionista/quotista decida vender as suas ações/quotas na Target a um terceiro. 
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Disposições Relevantes  – Acordo de Acionistas/Quotistas 

 

C. Call Option / Put Option 

- Put option – Direito de vender a participação societária a outro acionista/quotista, mediante 

condições e preço pré-determinados 

- Call option - Direito de compra de participação societária de outro acionista/quotista, mediante 

condições e preço pré-determinados 

 

D. Administração da Target / Deadlock 

- A forma como se dará a administração da Target dependerá da estrutura societária previamente 

negociada e acordada para a mesma (pode ser alterada quando do Closing da aquisição parcial)  

- As questões relativas à administração da Target podem incluir assuntos como a aprovação de 

Business Plan, a aprovação da distribuição de dividendos, a nomeação de conselheiros e diretores, 

os poderes destes executivos e questões reservadas para os acionistas/quotistas, entre outros. 

- O acordo de acionistas/quotistas pode determinar a opção das partes para a resolução de impasse 

quando há uma divergência insuperável entre os acionistas/quotistas.  
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Muito obrigado! 

Trench, Rossi e Watanabe Advogados 
em cooperação com Baker & McKenzie 

 

Alberto Mori 

Sócio de M&A  

Tel: +55 11 3048-6908 

alberto.mori@trenchrossi.com 

www.trenchrossi.com  

www.bakermckenzie.com  

 

 

Flávia Rebello Pereira 

Sócia de TI e PI  

Tel: +55 11 3048-6908 

flavia.rebello@trenchrossi.com 

www.trenchrossi.com  

www.bakermckenzie.com  
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